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Creating a 2D Shop Drawing in IronCAD

Often, when you want to have a part made, the shop will ask for 2D drawings rather than a 3D CAD model. IronCAD
has built in functions that make it easy to turn a 3D model into a 2D part. First, save the scene (model) containing the
3D part for which you want to create a 2D shop drawing. From the pull down menus, select File - New — Drawing.
In the New Drawing dialog box, select one of the Workspace templates.
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When the selected drawing template opens, the menus, toolbars, and views change to provide an environment for

creating 2D drawings. The drawing environment with a typical template is displayed below.

If you work for a

company, they will have a standard template that includes the name of the company, the part name and number, who

drew the part, who approved the part, etc.
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Don’t worry that the drawing is empty. From the Create menu, select View — Standard (or select the Standard
View tool on the View toolbar). The Standard View Creation dialog box appears. Your part should appear in the
window on the right. By default, the currently loaded part is selected. To load an alternate part, use the Browse button
to select the file.
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Aside: If you want a different part, use the browse button to load it. If the scene file contains more than one
configuration, select the desired configuration from the Configuration drop-down list below the file name.

The preview window on the right shows the current front view direction of the 3D model. Use the orientation controls
below the preview window to achieve the desired front-view orientation.

From the buttons on the left, select the desired view(s) to display on the drawing. For a standard shop drawing, you
should select Top, T.F.R. (Top Front Right), Front, and Right. Press OK. The views you selected will appear in the
drawing.
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You can move the views in the drawing around by clicking on the view. A red box will appear around the view.
Move the cursor to the edge of the box. When the cursor changes to the move shape, you can drag the view to a
different part of the drawing.

Note: Think about the orientation of the part. At first, | was going to flip the handle over since that would be its
normal orientation. However, in this orientation, the machinist would not be able to see the detail on the bottom of
the handle.

You can use the toolbars to add dimensions, text, and other annotations. Look at the Dimensions toolbar, the
Annotations toolbar, and the Sheet Drawing tools to see your options. Save the drawing when you are done.

The following sections are from the IronCAD help files.

DRAWING SHEET

A drawing is composed of one or more sheets containing paper space onto which views are placed. Each sheet can be
independently labeled and its tab is displayed at the bottom of the sheet for quick access. To the left of the sheet tabs
are tools for scrolling through the various drawing sheets, similar to those used for scrolling through the 3D catalogs.
To reorder sheets, select the tab of the desired sheet to move, drag it to a new location, and release.

Drawing Template: When a new drawing is created, the user is first prompted to select a pre-defined drawing
template. Several standards-based templates of varying sizes provide paper space onto which views can be placed.
These templates can be used "as is" or as starting points for creating custom templates.

Sheet Setup: Once a drawing template has been selected and the drawing sheet displayed, you can use options on the
sheet pop-up menu to customize the sheet to fit your specific needs. This pop-up menu is accessed by right-clicking
on the sheet background. The available options are:

o Export. Select this option to export a sheet.
e Paste. Select this option to paste an item from the clipboard into the drawing.

e Units. Select this option to specify the length units to be used on the paper and in the views, as well as the
desired angle unit.

e Snap. Select this option to define snap behavior on the drawing.

e Sheet Setup. Select this option to specify a standard or custom-sized sheet and to determine sheet orientation.
There is also a display option that allows you to switch from the default line width to zero-width lines in the
drawing.

e Grid. Select this option to display a grid for the drawing, as well as define horizontal and vertical grid
spacing.

MAIN MENU BAR
The default main menu bar is the location of most of the commands required to create a drawing.

File Edit ‘iew Create Tools Window Help

File menu. In addition to providing options for loading, saving and printing your drawing, this menu also provides
options for exporting your drawing into other formats such as .DWG and .DXF. Sheet Setup is an additional unique
option available from the File menu and allows you to define the appearance of your current sheet by choosing either
a standard or custom drawing size, displayed in either Landscape or Portrait mode.

Edit menu. While containing the traditional options such as Undo, Redo, Cut, Copy, Paste, and Delete, this menu
also contains options for modifying drawing information. These include view parameters or annotation information
(dimensioning, GD&T symbols, text, hatching, etc.) and the creation and modification of named styles and layers,
default element properties, and user-defined symbols. You can also choose to edit an object or scene associated with
the drawing, delete a drawing sheet, or edit scene links.

View menu. This menu provides options for viewing toolbars, sheet grid, status bar, and curve dimensions, as well as
options for achieving optimum viewing of drawing components.
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Create menu. With the Create menu, you can create additional sheets or views within a sheet, dimensions, text with
leader, GD&T symbols, centerlines, and supplementary sheet geometry and text. It also allows you to create/insert a
new object and insert a Bill of Materials into the drawing.

Tools menu. This menu offers options for specifying: the angle projection method for standard views; engineering or
architectural view scale type; paper and view measurement units, snap behavior, and grid measurements; and general
purpose options, such as updating views, hiding parts/redisplaying hidden parts, and defining a cut part list. Other
features allow you to add/define tools, customize drawing menus and toolbars, and create custom macros with Visual
Basic Editor.

Window menu. The Window menu offers the standard options for Tiling/Cascading/ Creating windows. The active
drawing(s)/scene(s) are displayed at the bottom of the Windows drop-down menu, which allows you to switch
between the 2D and 3D interfaces.

Help menu. Includes standard Help options for accessing information about the product and its on-line help system.

THE VIEW TOOLS
The View tools are provided for creating and updating views in a drawing.

EcEeR

Standard Views

Standard views are those typically used in engineering drawings and are one of two view types used as foundations
for supporting views — the other is the General view. A drawing must contain a standard or general view before
supporting detail, section, auxiliary, or general views can be created.

There are two angle projection methods for determining standard view placement on a drawing: first angle and third
angle. First angle is the default method and its associated view options will automatically be displayed when you
begin creation of a standard view. However, if you require third angle projection, this option must be specified before
beginning standard view creation. To enable this option, select Angle Projection Method from the Tools menu, select
third angle on the resulting dialog box, and then choose OK.

View Pop-up Menu
Right-clicking in a view displays its pop-up menu with several key options:

o Delete. Select this option to delete the selected view.
o Edit Scene. Select this option to access/edit the scene associated with the selected view.
e Update View. Select this option to update the selected view to reflect any changes in its associated scene.

e Shaded Rendering. Select this option to display the surface rendering from the associated scene on the
part(s) in the selected view.

e Break Alignment. Select this option to break alignment between the selected view and its parent or front
view.

e Hidden Parts List.
e Hide Part. Select this option to hide specified parts in the selected view.
¢ Re-display Hidden Part. Select this option to redisplay specified hidden parts in the selected view.
e Display All. Select this option to redisplay all hidden parts in the selected view.

e Cut-parts list.

¢ Add/Remove Parts. Select this option to add/remove specified parts in the selected view to/from a list of parts
that are not to be cut in any view.

e Clear list. Select this option to clear all items from the cut parts list.

e Hidden Threads.

¢ Hide Thread Data. Select this option to activate the Hidden Threads session bar for defining cosmetic thread
and callout data to be hidden in the selected view.
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e Show Thread Data. Select this option to activate the Hidden Threads session bar for defining cosmetic thread
and callout data to be displayed in the selected view.

o Hide All. Select this option to hide all cosmetic thread and callout data in the selected view.
o Show All. Select this option to display all cosmetic thread and callout data in the selected view.

o Edit View. Select this option to display the Edit View session bar to specify catch behavior and then use the
Sheet Drawing tools to add 2D geometry to the selected view.

o Hatched Region. Select this option to display/define the Hatch Style properties for a selected section view.
e Properties. Select this option to access/define properties for the selected view.

POSITIONING VIEWS

As drawing creation progresses, it may, at times, be necessary to reposition views on a sheet. This is a simple
operation, since all orthographic views are fully associative, which facilitates the layout process, offering quick,
precise view placement.

Repositioning Support Views

Standard drawing views are automatically aligned and positioned relative to each other. They are also positioned on
grid line intersections to facilitate alignment of support views.

Moving Views to a Different Sheet within a Drawing

You can easily reposition a drawing view to a different sheet within a drawing by selecting it and dragging it onto the
desired Sheet Tab at the bottom of the drawing.

Repositioning Front Views

An important feature is the associative nature of orthographic drawing views. Their movements are constrained to the
front view. Moving the front view will automatically reposition the other orthographic views accordingly. To break
the associativity of an orthographic view, right-click on the associated view and select Break Alignment from the
resulting pop-up menu.

Repositioning General and Isometric Views

General and isometric drawing views are not aligned to any other view. They can be repositioned anywhere on the
sheet.

To reposition a newly created general or isometric view on the drawing sheet:
1. Select the general or isometric view. When selected, a green dot will appear at the center of the view and its
frame border will be displayed.
2. Reposition the view on the drawing sheet.

3. Move the cursor over the frame border until the cursor changes to a four-way arrow. Click and drag the
selected view to the desired location and release.

Repositioning View Labels
View labels are repositioned in the same manner as general and isometric views. To move a view label to an alternate

location, first select the view with which it is associated. Move the cursor over the label until it changes to a hand with
text icon and then click and drag the label to the desired location.

DIMENSIONS

Simple functionality is provided for creating new dimensions on drawing views and for setting dimension properties
and styles. Also offered is the option of transferring 2D and 3D dimensions from the scene to appropriate drawing
views. Dimensions can be added to any 2D geometry, reference or not. Those added to the 2D drawing view(s) are
fully associative to the actual 3D part geometry. Whenever dimensions are added to a view, the part file is loaded in
the background. The following tools are available for adding dimensions to a 2D drawing view:

e SmartDimension Diameter Dimension
e Horizontal Dimension Angle/Distance Edge Dimension
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e Vertical Dimension Ordinate Dimension
e Radial Dimension
e Baseline Dimension

These tools can be accessed on the Dimensions toolbar or by selecting Dimension from the Create menu. Once a
dimension type has been selected, SmartSnap feedback (green highlighting) is displayed as the cursor moves over the
drawing view to indicate when an allowable attachment point has been detected. When a 3D element is detected
which is not an allowable attachment point, a shaded "no entry" symbol is displayed.

While all the Dimensions tools allow you to add dimensions to a drawing, the SmartDimension tool is the only one
that allows you to add a variety of dimension types with the selection of a single tool. It allows you to place almost
any type of dimension on geometry, using the mouse in combination with the Tab key. The remaining Dimensions
tools, except for Angle/Distance Edge, Ordinate, and Baseline, function identically to the SmartDimension tool except
that they restrict placement to one dimension type until another Dimensions tool is selected.

Placing a SmartDimension between two points

To place a SmartDimension between two points: Dimensions can be placed for a line's x and y axis components, as
well as its linear dimension from start to endpoint.

1. Select the SmartDimension option.

2. Select the start vertex for the desired dimension.

3. Select the end vertex for the desired dimension.

4. Select the desired dimension to display.

Use the Tab key to cycle through the available dimensions: the x-axis component, y-axis component, and linear
dimension from start to end point. Alternately, you can use a series of right-mouse-clicks to cycle through the
options. When the desired dimension is displayed, click to select it.

5. Place the dimension.

6. Move the cursor linearly to the desired location to display the dimension and then click to place it.

Placing a SmartDimension between two parallel edges:
NOTE: This process applies to SmartDimensions placed between any linear edges, including linear silhouette edges
that are generated from cylinders, cones, elliptical cylinders, and elliptical cones.

1. Select the SmartDimension option.

2. While depressing the Shi ft key, select the first edge to be referenced in creating the dimension. Move the
cursor over the desired edge until it is highlighted in green and then click to select it. Do not release the Shift
key.

3. Select the second edge to be referenced. The second edge must be parallel to the first in order to create a
linear dimension; if the second edge is not parallel to the first, an angular dimension will be created.

4. When the second edge is highlighted in green, click to select it.

5. Place the dimension.

Move the cursor linearly to the desired location to display the dimension and then click to place it. Also use the above
steps to place a dimension with the Horizontal or Vertical Dimension tool.
Placing a SmartDimension on aline

NOTE: This process applies to SmartDimensions placed on any linear edge, including linear silhouette edges that are
generated from cylinders, cones, elliptical cylinders, and elliptical cones.

1. Select the SmartDimension option.

2. Select the desired line to which the dimension should be added.

Move the cursor over the line until the line itself is highlighted in green and then click to select it. 3. Display the
desired dimension.
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Use the Tab key to cycle through the available dimensions. Alternately, you can use a series of right-mouse-clicks to
cycle through the options. Do not click to select, but move to the next step when the desired dimension is displayed.
4. Place the dimension.

Move the cursor linearly to the desired location to display the dimension and then click to place it. Also use the above
steps to place a dimension with the Horizontal or Vertical Dimension tool.

Placing a SmartDimension on aradius or diameter of a circle

1. Select the SmartDimension option.
2. Select the circumference of a circle or arc to which the dimension should be added.

3. Move the cursor over the circumference until it is highlighted in green. Click on the desired point with which
to align the diameter or radius dimension.

Also use the above steps to place a dimension with the Diameter or Radial Dimension tool.
Placing a SmartDimension on an angle between two edges:

1. Select the SmartDimension option.

2. While depressing the Shift key, select the first linear element to be referenced in creating the angle dimension.
Move the cursor over the desired linear element until it is highlighted in green and then click to select it. Do
not release the Shift key.

3. Select the second linear element to be referenced. The second linear element must not be parallel to the first
if you want to create an angular dimension between the two. If the second element is parallel to the first, a
dimension will be applied that reflects the distance along the shortest imaginary line extending between them.

4. When the second linear element is highlighted in green, click to select it. 5. Place the dimension.
Move the cursor linearly, away from the narrower end of the angle, to the desired location to display the dimension
and then click to place it.

To add a dimension using the Edge/Angle Distance tool, the steps are identical to those above, except it is not
necessary to depress the Shift key when selecting the linear elements to be referenced.

Angular dimension displays can be repositioned directly opposite its current location by selecting the value display
and dragging towards and past the vertex of the angle and then releasing. Angular dimension values can be
repositioned to the side of the angle display by selecting the value and dragging towards and past either endpoint of
the arc.
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